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Overview 
 

• Getting Started  

• Exploring the DS3000 Storage Manager  

o Tab Screen Views 

• Touring the DS3000 Storage Manager Simulator  

• Scenarios  

o Scenario 1: Limited IT Expertise and Time  

o Scenario 2: Newly Added Drives to be Configured  

o Scenario 3: Increasing Data Protection  

o Scenario 4: Adding Capacity  

o Scenario 5: Adding Additional Security to an IP SAN (DS3300-specific)  

o Scenario 6: Tiered Storage within a Single Enclosure 

• Premium License Feature Scenarios  

o Scenario 1: Sharing Data  

o Scenario 2: Improving Service Levels with Hot Backups  

o Scenario 3: Relocating Data 

• Advanced Features and Manual Functions  

o Manual Hot Spare Configuration  

o Manual Drive Configuration  

o Media Scan Settings  

 

 

www.ercanpamuk.com


www.ercanpam
uk.com

Linux, Unix, Aix Bilgi Platform
u

DS3000 Storage Manager Software Demo Guide – 2.7 - 3 - 

Disclaimer 
 

The intent of the DS3000 Storage Manager Demo software and this Demo Guide is to provide 
administrators a tool to become familiar with the features, functions and power of the DS3000 Storage 
Manager software.  

At the time these tools are released and internally distributed, there may be minor errors, yet do not result 
in intentional misrepresentation of the DS3000 Storage Manager or DS3000 disk system’s capability.  
However, the Demo is not tested, updated, nor maintained to the extent of the actual products offered for 
customer use.  As a result, certain features and functionality may differ from a production release of the 
DS3000 Storage Manager.  

Technical questions should be verified through official published documents, support resources, or 
directed to appropriate Systems Engineers, field support or customer service personnel.  
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Getting Started 
 
Audience 
Welcome to the DS3000 Storage Manager Demo Guide.  

The audience for this demo guide is technically-oriented administrators who desire to understand more 
about the features and capabilities of the DS3000 Storage Manager. 

 
Background Information 
The DS3000 Storage Manager Demo software is designed for use in testing environments as a stand-
alone simulator of DS3000 Storage Manager’s functions.  To prevent accidental access or corruption of 
critical data, the Storage Manager Demo does not have the ability to access actual storage disk systems.  

 

Prerequisites 
The Storage Manager Demo software runs on Windows 2003 or XP environments.  Other environments 
have not been tested, nor are they approved for use. 

 

Terminology 
To ensure you are familiar with the terminology in this Demo Guide, we will provide you with a short 
summary of terms.   

Array: A set of physical drives logically grouped together with an assigned RAID level.  Arrays can vary in 
the number of drives to meet required data protection, capacity, or performance requirements (the more 
physical drives in an array, the higher the performance capability of the array). 

FlashCopy: This feature provides the ability to create a point-in-time image of a logical drive. It is very 
useful for as a data source for backup applications. 

Host-to-Logical-Drive-Mappings: When there are several hosts and many logical drives to associate to 
these hosts, Host-to-Logical-Drive-Mappings are utilized to configure a set of logical drives to each host 
server. We use the partitioning feature to assist in this process 

Logical Drive: This is the basic storage unit that is created on the DS3000 and presented to a host server. 
It is synonymous with LUN and is a drive letter (H: for example) in Windows environments. 

Partition: This premium feature logically divides a single disk system into multiple systems by defining 
which host or host group can access each logical drive. This enables a range of hosts with different 
capacity, performance, or data protection demands to effectively share a single storage system. 

Storage subsystem:  This term will be used interchangeably with disk system.  Both refer to the DS3000 
series disk systems which are managed by the DS3000 Storage Manager 

VolumeCopy: This feature provides the ability to create an independent copy of another logical drive or 
FlashCopy. This term is also used interchangeably with logical drive copy. 

 

Loading the Software 
The Demo is a zip file with the following name: DS3KSM_270_V9.zip. Save this zip file into a folder of 
your choice. Then, extract the zip file within this same folder.  Within this folder will be the DEMO folder.  
Simply navigate there and execute the batch file named Start_Demo.bat.   And you are ready to go! 
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Exploring the DS3000 Storage Manager Demo  
 

Executing the Start_Demo.bat initiates a Java session with the Storage Manager Demo program. You will 
see the following screens – the DS3000 Storage Manager splash screen identifying the Storage Manager 
Demo and the Enterprise Management Window screens. 
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The Enterprise Management Window Task Assistant is a series of wizards that helps you install and 
manage your new DS3000 disk system.  The Task Assistant helps with common tasks such as: 

 Add Storage Subsystems 

 Name/Rename Storage Subsystems 

 Configure Alerts 

 Manage a Storage Subsystem 

Feel free to explore the Task Assistant.  You can auto-discover the storage subsystems by selecting 
Add Storage Subsystem from the Task Assistant, or closing the Task Assistant window  
and clicking on the leftmost icon button in the Enterprise Management Window.   

 
__________________________________________________________________________________ 

Note: In subsequent sessions, the storage subsystems may not need to be rediscovered. However, if the 
subsystem status is “unresponsive,” simply delete the systems and rediscover them. 
__________________________________________________________________________________ 

 

In the right panel of the Enterprise Management window, you will see three preconfigured storage 
systems: 1) the DS3200, 2) the DS3300, and 3) the DS3400. 

With various systems to choose from, you can select the appropriate subsystem to view and leverage the 
features you wish:   

1) The DS3200 is ideal for an in-depth exploration of the DS3000 Storage Manager feature set. 
Nothing is pre-defined for the subsystem, so it can serve as a basis for configuring all the arrays, 
logical drives and host-to-volume mappings. 

2) The DS3300 is suitable for a comprehensive tour of the DS3000 Storage Manager features. It 
includes a number of defined arrays and logical drives.  

3) The DS3400 is also suitable for a comprehensive tour of the DS3000 Storage Manager features. 
It includes a number of defined arrays and logical drives.  

Each configuration includes a total of 48 SAS and SATA drives and 3 EXP3000 drive trays. In addition, all 
premium features, FlashCopy, VolumeCopy and partitioning, are enabled. 

It is important to note that the DS3200, DS3300 and DS3400 are identical in their functionality.  The 
features and tasks presented in this guide can be used interchangeably.  

 

www.ercanpamuk.com


www.ercanpam
uk.com

Linux, Unix, Aix Bilgi Platform
u

DS3000 Storage Manager Software Demo Guide – 2.7 - 7 - 

Tab Bar Screen Views 
For this initial exploration of the Storage Manager Demo, we will use the DS3300 disk system 
configuration.  

 
Select the DS3300 system by double-clicking it in the right panel.  This displays the DS3000 Subsystem 
Management window (SMW). 

 

The SMW provides access to most components and functions of the DS3000 series disk systems.  
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There are six tabs in the SMW view. 

 
 

 The Summary tab provides access to:  
o Initial Setup Tasks link  
o Recovery Guru - This is the automatic discovery tool for systems problems 
o Hardware components - profile and drive location 
o Locate arrays and logical drives - Drive group and disk system targets (LUNS) 
o Host and mappings - The attachment of LUNs to servers  
o Information center and online help 

 
• The Configure tab provides access to:  

o Configure host access – Automatic or manual 
o Create host group – A group of servers or cluster 
o Automatic storage configuration 
o Configure Hot Spares 
o Create logical drives (including FlashCopy logical drives) 
o Create host-to-logical drive mappings – Server to LUN 

 
• The Modify tab provides access to: 

o Edit host topology - Servers using LUNs 
o Rename or delete logical drives 
o Add free capacity - Drive space available in the arrays and not yet assigned to a logical-drive) 
o Change logical drive ownership (preferred path) - Route from/to server and disk system 
o Modify FlashCopy logical drives - Drive used for FlashCopy 
o Manage logical drive copies - Premium feature of VolumeCopy or logical drive copy 
o Edit host-to-logical drive mappings 

 
• The Tools tab provides access to: 

o Rename storage subsystem 
o Set or change password 
o Change media scan settings - System data block check done in the background 
o Turn on indicator lights for various components to identify them physically (e.g. locate a drive) 
o View/enable premium features 
o Change enclosure ID numbers - Identification number assigned to a expansion unit 
o Synchronize controller clocks 
o Change controller network configuration - Set IP address information 
o Reset battery age - Days until battery replacement should be made 
o Inherit system settings – Leverage already existing array configurations 
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• The iSCSI tab manages DS3300 IP SAN configurations such as: 
o Change Target Authentication 
o Enter Mutual Authentication Permissions 
o Change Target Identification 
o Change Target Discovery 
o Configure iSCSI Host Ports 
o View/End iSCSI Sessions 
o View iSCSI Statistics 

 
• The Support tab provides troubleshooting and maintenance access to:   

o Recover from failure 
o View event log 
o Gather support information 
o View storage subsystem profile 
o Download firmware 
o Manage controllers 
o View online help 
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Touring the DS3000 Storage Manager Simulator 
 

Selecting a disk system for your organization can be a difficult decision as there are various requirements 
in your selection process.  The DS3000 Storage Manager Simulator is useful for discovering which 
features are most important to you and why.  

In addition, the simulator is a valuable tool for training your staff who will be administering the IBM 
DS3000 disk systems.  They can quickly come up to speed on managing the DS3000 Storage Manager, 
become familiar with its ease-of-use, as well as address any of their concerns about learning a new 
software system.  Stressing the task-oriented user interface and its simplicity, training your staff can be 
tailored to their specific needs: 

 Initial set-up and configuration 

 Basic operations for your particular environment 

 Advanced premium features  

 Specific operations for growing the disk system 

 Application specific tips and techniques 
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Scenarios 
The following sections will provide some real-world scenarios so you can become familiar with the 
DS3000 Storage Manager functions in relation to specific business issues. 

 
Scenario 1: “This is my first external storage system. What do I do?” 
Initial Setup Tasks dialog box 
 

The DS3000 Storage Manager’s Initial Setup Tasks dialog box provides step-by-step instructions on 
setting up a DS3000 disk system.  As a task-based user interface, it provides a more obvious starting 
point for setting-up and managing the disk system.    

The Initial Setup Tasks window offers a step-by-step process of tasks to complete an initial 
configuration.  It comes up automatically when the SMW is first brought up, or can be launched by 
selecting Perform Initial Setup Tasks from the summary tab of the SMW.  

The steps listed as initial setup tasks include: 

1. Locate the storage subsystem 

2. Rename the storage subsystem 

3. Set a storage subsystem password 

4. Configure iSCSI host ports 

5. Configure host access 

6. Configure the storage subsystem 

 

In this scenario, we will cover each step in the Initial Setup 
Tasks list.  
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Step 1:  Locate the Disk System  
 
This optional step helps locate the subsystem if it is in a data center or room with other systems. Click on 
Locate the Storage Subsystem to view the following screen:  

 
 

From this screen, select an item and click Locate to have the lights on the DS3000 disk system indicate 
its location. This allows you to locate the physical location of the disk system in your network.  The disk 
system can then be identified with a label.  
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Step 2:  Rename the Storage Subsystem 
 
This optional step allows you to rename the subsystem. Click on Rename the Storage Subsystem to 
view the following screen: 
 

 
 
Enter the new subsystem name and click OK.  

Step 3: Set a Storage Subsystem Password 

This optional step allows you to set a password for the subsystem, so that unauthorized users can not 
make changes. Click on Set a Storage Subsystem Password to go to the following screen: 

  
 

Enter the current password (if applicable) and the new password twice, then click OK.  You will receive 
confirmation that your new password has been set up.  
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Step 4: Configure iSCSI Host Ports (DS3300 only) 

This step allows you to configure network parameters for the iSCSI host ports on the DS3300 controller 
module(s).  From the Initial Setup Tasks window, select Configure iSCSI Host Ports.  Once at the 
iSCSI Host Ports window, you can see that each host port is identified and configured by the controller 
number and port location.  Select one of the ports.  After the port is chosen, you have the option of 
obtaining the configuration automatically from the DHCP server or the IP address can be manually 
entered.  
 

 

For this example, select the automatic configuration option.  

The ICMP PING responses have now been enabled. The Internet Control Message Protocol (ICMP) is 
one of the core protocols of the Internet protocol suite. The operating systems of networked computers 
use this protocol to send messages. ICMP contains a ping tool, which sends ICMP Echo Request 
messages (and receives Echo Response messages). These ICMP messages determine whether a host 
is reachable and how long it takes to get packets to and from that host. Whether enabled or disabled, this 
selection will apply to all iSCSI host ports in the DS3300.   

Select OK.  You will then receive confirmation that the configuration of the iSCSI host port has been 
completed.  
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Step 5: Configure Host Access   

This step allows you to provide one or more hosts to access the subsystem. Select Configure Host 
Access, which will direct you to the following window: 

 
After selecting the appropriate host, click Add and then OK.  You will then receive confirmation of host 
access.  
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__________________________________________________________________________________ 

Note: In the Demo, several hosts have been pre-configured for access. 
__________________________________________________________________________________ 

 

Step 6: Configure the Storage Subsystem   

This step has two options:  the Automatic (Simple) option and the Manual (Advanced) option.  The 
Automatic (Simple) option is the quickest and easiest, but provides limited control over your 
configuration. It will be covered in this scenario.  The Manual (Advanced) option still provides some 
automated assistance, yet allows the user to have more control of the configuration and will likely be 
preferred in most situations.  It will be covered in Scenario 2 with the creation of logical drives. 

Automatic (Simple) Configuration 

Select the Automatic (Simple) option under Configure the Storage Subsystem and select Step 1: 
Automatic Configuration. This will open the Automatic Configuration window.  You will proceed to 
choose a RAID level and click Finish. Storage Manager will then configure the entire subsystem into 
multiple arrays based on the selected RAID level and create a single logical drive within each array.  

________________________________________________________________________________ 

Note: If you wish to define the number of drives in each array, and the number and size of the logical 
drives in each array, select the Create Logical Drives option. 
________________________________________________________________________________ 
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After reviewing your configuration options with RAID 5, return to the task window and select Step 2: 
Create Host-to-Logical Drive Mappings. This will open the Create Host-to-Logical Drive Mappings 
window.  Select the host you would like to map and click Next.  

 
Select the logical drives you want to be mapped to the host and click Finish. If more than one logical 
drive is selected, the logical unit number will be assigned automatically. If only one logical drive is 
selected, you will also be prompted to assign it a logical unit number (see below). 
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After this process has been completed, click OK and you will be notified that you have successfully 
mapped the host to a logical drive.  You will be given the option to map another host-to-logical drive. For 
this example, select NO. 

 
You have successfully created arrays, logical drives and mapped logical drives to a host with the simple 
Automatic option.  
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Scenario 2: “I have newly added drives that I would like configure.” 
Logical Drive Creation 
 

Like many configuration tasks within Storage Manager, logical drive creation can be an Automatic or 
Manual task.  In this scenario, the Automatic (recommended) option will be covered. The Manual option 
is covered in the Advanced Scenarios section on page 43.    

From the Configure tab, or from the Initial Setup Tasks window under the Manual (advanced) option, 
select Create Logical Drives. This will take you to the Create Logical Drives – Select Capacity Type 
window to decide which drive type and capacity you prefer. 

 
Select Unconfigured Capacity, SAS drives, and click Next.  Automatic or Manual configuration 
options will appear.  Select Automatic and Next.  
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At the Create Logical Drives – Specify Capacity window, first select the RAID level desired.  Then, 
choose an array from the list of array options based on the number and type of drives in the configuration. 
Click Next.  

 
The next window, Create Logical Drives – Specify Logical Drive, requires you to select the logical drive 
capacity from the free capacity that is available, name the logical drive and identify its I/O characteristics.   
We will select 200GB capacity, name the logical drive Marketing and select the I/O characteristics based 
on a file system application.  
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The Create Logical Drives – Map Logical Drive to Host window will allow you to map your logical drive 
to a host group or individual host. We will map it to Host Berkley and assign it one LUN. Click Finish.  

  
You will receive confirmation that the creation of your logical drive has been completed! 
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Scenario 3:  “I want to protect against a failed drive.” 
Automatic Hot Spare Drive Configuration 
A Hot Spare Drive is an unassigned drive that automatically replaces a drive if a drive fails. The Hot 
Spare Drive adds another level of data protection by acting as a “reserve” drive in the instance of a drive 
failure.  

From the Configure tab, select Configure Hot Spares.  

 
For this scenario, select Configure Hot Spares (Automatic).  
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___________________________________________________________________________________ 

Note: Use the Create Hot Spare (Manual) when assigning specific drives or viewing/making changes to 
the current hot spare coverage. The manual process is covered in the Advanced Scenarios section on 
page 41. 
____________________________________________________________________________________ 

At the Configure Hot Spares (Automatic) window, the proper number of hot spare drives required to 
provide optimal coverage for the storage array will automatically be assigned. 

 
Select Assign. 

 
You will receive confirmation of the number of hot spares that have been configured successfully. 
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Scenario 4:  “How do I add capacity to an array?” 
Expanding Drive Capacity (Dynamic Array Expansion) 
The DS3000 Storage Manager provides a simple method of expanding the capacity of an array by adding 
more drives to it. This increases performance and capacity of the disk system.  

 

First, select the Modify tab. Click Add Free Capacity (Drives).  

 
The window Add Free Capacity (Drives) – Selected Array will then prompt you to select the desired 
array to add drives to. Click Next. 

 
You are almost there!  At the Add Free Capacity (Drives) – Select Capacity screen, the DS3000 
Storage Manager will provide some status information about the array you selected.  From here you can 
add one or two drives to the existing disk system. (Note: this process can be repeated if desired). Click 
Finish.  
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The process of adding free capacity starts.  

 
__________________________________________________________________________________ 

Note: This operation will take an extended period of time to complete and you cannot cancel it once it 
starts. However, the data on the volume group will remain accessible. 
__________________________________________________________________________________ 
 

You can monitor the process of this operation by viewing the volume and array displays. 
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Scenario 5: “I would like to add additional security to my IP SAN (DS3300 
only).” 
Change Target Authentication  
A best practice for an IP SAN is to separate storage traffic from normal LAN traffic by deploying IP 
storage traffic to a physically separate network. In addition to maintaining an IP SAN separate from the 
rest of network, iSCSI inherently provides its own protection which can be leveraged as an additional 
security measure. An example of this protection is CHAP (Challenge Handshake Authentication Protocol), 
which is used to verify the identity of iSCSI host systems that are attempting to access storage targets in 
which the iSCSI initiator and iSCSI target share a predefined secret. If the secret values match, the 
initiator is authenticated and a session can begin.  
To enable CHAP, go to the iSCSI tab and select Change Target Authentication.  

 
At the Change Target Authentication window, CHAP is disabled by default. For this example, we would 
like to enable CHAP.   

 
Click the CHAP prompt and then click the CHAP Secret button. This will open the CHAP secret prompt.   
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Enter the target CHAP secret, re-enter for confirmation and select OK. The target CHAP secret can also 
be randomly created by selecting the Generate Random Secret tab. You will then return to the Change 
Target Authentication window.  Click OK to receive confirmation that a CHAP secret has been enabled.  
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Scenario 6: ‘How do I achieve tiered storage within a single enclosure?”  
 
Today, the growth of applications and the need for 24x7 availability are likely reasons your organization is 
experiencing increased data requirements.  In addition, new laws requiring extensive archiving of 
corporate information also fuel this demand.  
The dilemma is how to keep more data online while keeping costs down.  
The DS3000 series of systems offer a unique solution to this predicament. A key attribute of the DS3000 
series of disk systems is the integration of SAS and SATA technologies within the same enclosure.  SAS 
drives are notable for high availability and typically utilized for mainstream transaction-based applications 
while SATA technology is generally deployed for near-line data and can drastically reduce the cost of a 
storage investment when cost/GB is the most important factor.  By optimizing the right workload demand 
with the appropriate drive technology, the DS3000 disk system can cost effectively support your 
organization’s entire range of data capacity requirements.  
The DS3000 series of disk systems are an ideal platform with up to 9.0TB in a compact 2U package that 
offers the lowest cost per MB and capacity expansion up to 36.0TB.   It is an ideal blend of capacity, 
performance, manageability, and reliability. Its ability to solve business problems with an appealing cost 
advantage makes it an excellent storage solution for applications such as: 
• Keeping more information online for quicker access  
• Online backups to disk for faster recovery 
• Moving data from online databases to data warehouse applications, datamarts and decision support 

systems 
 
As volume/RAID groups can only be created with same drive types, the DS3000 Storage Manager 
ensures that such a configuration cannot be created.  When creating logical in the automatic mode the 
user is prompted to select from same-type drive groups.  
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In manual mode only same-type drives are allowed to be added to the volume/RAID group. 
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DS3000 Storage Manager Premium License Features 
The Premium Feature Licenses offered with the DS3000 Storage Manager includes Partitioning, 
FlashCopy and VolumeCopy.  

These features can be viewed and enabled by accessing the Tools tab on the main tool bar.  

As you can see in the following window, all Premium Features have been enabled. For these Premium 
Features to be enabled, a Feature Enable Identifier was entered.  This Feature Enable Identifier is 
provided when a one of the following Premium Features are purchased.  

 
 

The following scenarios will familiarize you with the premium features of the DS3000 Storage Manager. 
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Premium Feature Scenario 1: “How can I share capacity across my hosts?” 
Storage Partitioning  
Storage partitions are created when you define Host-to-logical Drive Mappings. Partitioning allows you 
to create multiple virtual systems from a single DS3000 series disk system. Each partition represents a 
virtual disk system and consists of one or more logical drives assigned to an individual server or group of 
servers.  

Create Host-to-Logical Drive Mapping can be administered by going to the Configure tab. At the 
Configure window, select Create Host-to-Logical Drive Mappings.  

 
This will open the Create Host-to-Logical Drive Mappings - Select Host window.  

 
Select the host you would like to map and click Next. This will take you to the Create Host-to-Logical 
Drive Mappings – Select Logical Drives screen.  You then select the logical drive(s) you wish to be 
mapped to the host.  

 

 

__________________________________________________________________________________ 
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Note: Unmapped logical drives will need to be created to reveal this feature. 
__________________________________________________________________________________ 
 

 
If more than one logical drive is selected, the logical unit numbers will be assigned automatically. If only 
one logical drive is selected, you will also be prompted to assign it a logical unit number. 

Select Finish following your logical drive selection.  

    
 

After this process has been completed, click OK. You will then be notified if the host-to-logical drive 
mapping was a success and asked if you would like to map another host-to-logical drive. For this 
example, select NO. 

You have successfully mapped a host to a logical drive! 
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Premium Feature Scenario 2:  “How do I improve my application service 
levels with hot backups?” 
FlashCopy  
One significant business problem that the IBM DS3000 Storage Manager helps eliminate is the ever-
increasing amount of time it takes to complete a backup of applications.  As data grows, the time to back 
it up also grows. The difficulty of provisioning time for backups in a 24x7 environment can be a challenge.   

The DS3000 Storage Manager’s FlashCopy feature minimizes the amount of time the application I/O 
must be suspended, or the amount of time the application is in hot backup mode.   

Instead of impacting the application for the length of the backup process, FlashCopy is used to create a 
nearly instantaneous image of the source data. The application can then come out of hot backup mode 
and resume normal processing while the backup application begins copying the point-in-time FlashCopy 
to the desired target.  

FlashCopy can be used to create a point-in-time image of any standard logical drive at any time, as long 
as there are no tasks (such as rebuilds or expansions) in process on that logical drive.  

Touring the DS3000 Storage Manager’s FlashCopy function will show the reduction in backup length.  

 
Once the FlashCopy feature is enabled (see page 31), go to the Configure tab and select Create 
FlashCopy Logical Drives.  

 _____________________________________________________________________________ 

Note: You must refer to the specific instructions in online help for your host OS before creating a 
FlashCopy. Failure to complete the steps listed for your host OS may result in loss of FlashCopy data 
consistency.  You will also receive a dialog box reminding you of this before you proceed. 
_____________________________________________________________________________ 
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At the Create FlashCopy Logical Drives - Select Base Logical Drive window, select the logical drive 
that you want to create a FlashCopy image of.   

 
Also note that when you create a FlashCopy logical drive, you automatically create a FlashCopy 
Repository logical drive.  A FlashCopy Repository logical drive stores information about the data that has 
changed since the FlashCopy logical drive was created. Repository logical drives are reserved for 
DS3000 Storage Manager use. For example, you cannot select a FlashCopy Repository logical drive for 
use as a base logical drive or as a target logical drive in a FlashCopy or VolumeCopy operation.  

After your logical drive selection, you will be asked to select a path. You have the choice of taking the 
Simple setup, or the Advanced setup for more control over the FlashCopy parameters. For this example, 
we will select the Simple option.   

 
You will then be able to change the default logical drive names if desired.  
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Once you specify the appropriate names and click Next, you will select which host or host groups you 
would like the FlashCopy mapped to. 

 
After selecting the host or host group mapping, assign a LUN and Finish. This will complete your 
FlashCopy logical drive creation. A Summary screen will open which shows summary information 
regarding the logical drive and the FlashCopy point-in-time image.  
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Premium Feature Scenario 3:  “How can I create an independent copy of 
my data?” 
VolumeCopy  
Another premium feature of the DS3000 Storage Manager is VolumeCopy. VolumeCopy creates a 
complete physical copy, or a clone, of a logical drive within a disk system. The clone is a unique entity 
that can be assigned to any host and used by applications requiring a point-in-time (PiT) copy of 
production data without affecting the performance of that production data. This feature is typically used in 
conjunction with FlashCopy to provide an independent copy of a point-in-time FlashCopy logical drive.  

Once the VolumeCopy feature is enabled (see page 31), go to the Configure tab and select Create 
Logical Drive Copies. 

 
At the Create Logical Drive Copies – Select Source Logical Drive window, select the logical drive you 
wish to copy.   

 
You will then be directed to the Create Logical Drive Copies – Select Target Logical Drive.  Select the 
logical drive that will be the target copy and click Next.   
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____________________________________________________________________________________ 

Note: Starting the copy process will overwrite all existing data on the target logical drive and the logical 
drive will go into READ-ONLY mode during the copy. Therefore, the best practice is to copy a FlashCopy 
image, which will maintain access to the production data. 
____________________________________________________________________________________ 

The Create Logical Drive Copies – Set Copy Priority window will then appear so you can change the 
copy priority to designate how the disk resources should be used when creating the copy. This gives you 
the option to minimize copy time or the overall I/O impact to your disk system. 

  
Move the priority bar between Lowest and Highest and click Next.   
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The final window, Create Logical Drive Copies – Confirm Copy Settings, reviews the source logical 
drive, target logical drive and priority settings you have selected.  As this will overwrite all existing data on 
the target logical drive and make the source logical drive Read-Only while it is being copied, it is 
important to ensure that these settings are correct.   

 
At the available prompt, type yes and select Finish. The VolumeCopy finishes in a short period of time.  

 
And your VolumeCopy has been created! 
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 Advanced Features and Manual Functions 
This section of the DS3000 Storage Manager Demo Guide is intended to highlight some of the more 
advanced and manual features that the Storage Manager offers.  

You may find that your organization will not have a need for these advanced features.  However, as the 
complexity of your organization grows, you may decide to take advantage of these features or “take the 
wheel” by creating the specific configurations you have in mind versus a pre-set configuration that is 
offered through the automatic options.   
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Manual Hot Spare Configuration 
 

The manual Hot Spare configuration option is especially useful for assigning specific drives or viewing 
and making changes to the current hot spare coverage. 

From the Configure tab, select Configure Hot Spares.  You will then be directed to the Configure Hot 
Spares window.   

 

Select Configure Hot Spares (Manual). 

 
The Configure Hot Spares (Manual) screen provides the current hot spare drives in use and prompts 
you to select the drive type you wish to assign as the new hot spare drive.  
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For this example, select the SAS drive capacity, and click Assign.  

The Assign Hot Spares window will provide the available disk drives and fit the type of drive and 
capacity you specified.  Select the desired drive and click OK.   

 
You have completed the manual configuration of a Hot Spare drive.  
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Manual Logical Drive Configuration 
As we have previously created logical drives via the Automatic option (page 19-22), lets review the 
Manual (Advanced) option.  

From the Configure tab, select Create Logical Drives.    

 
At the Create Logical Drives – Select Capacity Type screen, you will choose capacity from either 
unconfigured capacity or free capacity from an existing array. Select Unconfigured Capacity and click 
Next.  
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From the Create Logical Drives - Drive Selection Choices window, select Manual (Advanced) and 
click Next. 

 
At the Create Logical Drives - Manual Drive Selection window, select the desired drives and Add them 
to the array.  

 
Once all the drives are selected, select Calculate Capacity to ensure the proposed array will meet your 
capacity and channel protection requirements.  Click Next. 
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Once the array is created, the Create Logical Drives – Specify Logical Drive window will display and 
the logical drive capacity, name and I/O characteristics are defined.  
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The Create Logical Drives – Map Logical Drive to Host window will allow you to map your logical drive 
to a host group or individual hosts. As this is the first logical drive to be mapped, we will assign it to LUN 
one.  Click Finish.  

 
You will receive confirmation that the creation of your logical drive has been completed! 
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Media Scan Settings 
 

The DS3000 Storage Manager has the ability to perform a background scan of media to ensure data 
integrity.  On the Tools tab select Change Media Scans Settings.  

 
At the Change Media Scans Settings dialog box, select the logical drives to scan (one or more) and 
select each drives’ settings (scan duration and redundancy check). Media scans can also be suspended 
from this window. Click OK and the operation begins. 
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